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The Eudora Pro 4.2 User Manual is on your CD in electronic form. If you would like a printed copy, 
you may print that, or order a printed copy from www.eudora.com or call 1-800-2-EUDORA.

This Quick Start Guide shows how to install and configure the Eudora Pro® Email software, hereafter known
as Eudora. It also provides keystroke shortcuts and basic email procedures such as sending and receiving
messages. For the Windows version, turn the booklet over.

You can find more information about Eudora in the "Eudora Pro 4.2 User Manual" included on the
installation CD. The manual is in Portable Document Format (PDF). To read the manual, use the 
Adobe® Acrobat Reader, a software utility also included on the CD.

After you install Eudora, you can access the manual and other Eudora documents by opening the 
Eudora Pro Applications folder and then the Documentation folder. To open the manual, double-click 
on the Acrobat icon next to the user manual; Acrobat Reader automatically opens it.

The manual’s topics are linked. When you see a page number associated to a topic in the table of
contents, index, or in a reference, click the page number and that topic appears.

If you prefer, you can print the PDF manual. From the File menu in Acrobat Reader, choose Print. 
If you need help while using Eudora, go to the Help menu and choose a topic.

F I N D I N G  I N F O R M A T I O N
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Before you can successfully install Eudora, you need to know the following basic information about your email
account. Either your Internet Service Provider (ISP) or your email administrator can provide you with this information.

■ Return email address (Return address)

This is the email address that has been assigned to you by your ISP or your organization. It is the address other
people use to send you email. An example return address is jim@myfirm.com

Record your Return address here

■ User name (Username)

This is the name you use to log into your email account. Your ISP or organization provides it. It is generally, but not
necessarily, the name that appears before the at-sign (@) in your return email address (in the example above, "jim"
is the user name).

Record your Username here

■ Mail account password

This password lets you access your email account. Your ISP or organization provides it. Keep this password pri-
vate. 

■ Incoming mail server name (Mail Host)

Your incoming email account resides on a computer at your ISP or within your organization. Your
incoming mail server name is the full name of that computer, with no log-in name or at-sign (@)
required. For example: pop3mail.myfirm.com

Record your incoming mail server name (Mail Host name) here:

■ POP or IMAP

This is the protocol that your incoming mail server uses. Your incoming mail server uses one of the
following two Internet protocols, POP or IMAP, for storing and forwarding your mail. Ask your ISP or
your email administrator which one it uses.

Note. If you are setting up an IMAP account, it may require an IMAP Mailbox Location Prefix. Obtain
this from your ISP or your email administrator. Otherwise, leave the following box blank.

If applicable, record your IMAP Mailbox Location Prefix here:

■ Outgoing Mail Server Name

This server, an SMTP server, receives and processes all of your outgoing mail. It also resides on a computer
at your ISP or within your organization. The server name is often the same computer as your incoming
mail account. Your SMTP server name is the full name of that computer, with no log-in name or at-sign
(@) required, for example, smtp.myfirm. If your ISP or your email administrator has not given this server
name to you, you can leave the box blank.

Record your SMTP Server name here:

G E T T I N G  S T A R T E D  
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■ Your Registration Number

This number is provided in the Eudora product box. If you purchased this product through an electronic
reseller in software archive format, your registration number is provided in an accompanying email message. 

The registration number entitles you to receive technical support from QUALCOMM. Use this number
when registering your product electronically. If you are a member of an organization using Eudora, your
email administrator handles the registration process. 

Record your Registration Number here:

After you have recorded the above information, you are ready to install, configure, and register your copy
of Eudora.

If you are installing over a previous version of Eudora Pro or Eudora Light, all of your messages, mailboxes,
folders, filters, and settings are maintained.

To install Eudora, do the following:

1 Turn off any virus-protection software that you may have installed on your computer. (You do not have
to disable the Disinfectant™ extension.) Restart your Macintosh.

Important. Do not restart your Macintosh with extensions OFF because the installation CD may not
mount onto your desktop.

2 Quit all open applications.

4

3 If you are installing Eudora from a CD-ROM, insert the Eudora CD into your Macintosh CD-ROM
drive. If you are installing Eudora from a software archive, double-click on the archive.

4 Double-click on the Eudora Pro 4.2 Installer icon to launch the install program.

5 Click Continue in the Installer window, or press Return or Enter.

6 Read the Readme and click Accept. (To save the Readme to a file, click the Save... button. To print
the Readme, click the Print... button.)

7 Read the Software License Agreement and if you agree to the terms, click Agree.

8 Enter your User Code and click Continue. Your User Code number is printed on the technical support
information sheet found inside the Eudora product box, or if you are part of a multiple-user site, your
email administrator should provide it to you. If you purchased Eudora by electronic distribution, the
User Code is in the email message you received when you purchased the product. The user code and
registration numbers are two different numbers.

Note.  If you cannot determine your User Code, you may leave this field blank.

The Eudora Install dialog appears, allowing you to select which items you want to install. To see a
description of an item, click on the item.

9 To install Eudora and all of the items listed, select Full Eudora Pro Installation and click Install. 
Full Eudora Pro Installation is the default.

Note.  In the full install, QUALCOMM’s Pure Voice™ voice-messaging software and Apple’s 
QuickTime™ multimedia viewer are included. If by chance you have a newer version of QuickTime,
it will not be replaced.

To install Eudora only, select Eudora Pro Only. To install the Eudora documentation only, select
Documentation.

I N S T A L L I N G   E U D O R A
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10 When asked where you want to install the Eudora Pro Folder, select the destination folder and click
Install. A dialog appears indicating that your Macintosh may need to be restarted following installation.

11 Click Yes or No in the dialog to indicate whether you do or do not want your Macintosh automatically
restarted after install. Yes is recommended.

The install program begins installing the items you selected onto the appropriate locations on your disk.

12 When the installation is complete, you are prompted to restart your Macintosh if you selected Yes in
the step above. Click Restart to restart your Macintosh now or OK to restart later.

If you are a first-time Eudora user, you must now configure your email account using the information you
entered in the Getting Started section of this guide.

Note.  Your older Eudora Pro or Eudora Light mailboxes, settings, etc. will automatically be used by this
version. These files reside in the System folder located in the Eudora folder. Don’t move this folder if you
want to keep your previous settings. Only the "Application" folder is being replaced.

6

Sample Getting Started Settings

Getting Started Settings

Open Eudora. Go to the Eudora Pro Folder and double-click on the Eudora Pro application icon. 
The first time you launch Eudora, the Getting Started panel of the Settings dialog appears.

To check your settings according to the instructions here, and after launching Eudora, select Settings...
from the Special menu and click the Getting Started category on the left.

In the Getting Started Settings panel, enter the following information:

■ Your Real name (your first and last name as you wish it to appear in the sender line of your outgoing mail)

■ Your Username (recorded earlier)

■ Your Mail Host (incoming mail server name, recorded earlier)

■ Your Return address (recorded earlier), if it is different from the address you would get if you combine
your Username and Mail Host thus: username@mailhost

When you have finished entering this information, click OK to save your changes.

O P E N I N G  A N D  C O N F I G U R I N G   E U D O R A
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POP or IMAP

Your final step is to tell Eudora which Internet protocol your incoming mail server uses, as you recorded
it earlier in this guide:

1 Open the Settings dialog by selecting Settings... from the Special menu.

2 Click the Checking Mail category on the left. The Checking Mail Settings appear.

3 In the Server Configuration field, click the POP or IMAP button, depending on what you recorded
earlier in this guide. (If you are not sure, click POP. You can always change it later.)

Note.  If you select IMAP and you recorded an IMAP Mailbox Loca-tion Prefix earlier in this Guide,
enter that information in the IMAP Mailbox Location Prefix field that appears.

4 Click OK to save your changes.

Sample Checking Mail Settings (POP Server Configuration)
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SMTP Server Settings (if necessary)

If your SMTP (outgoing) server is on a different computer than your incoming mail server (your ISP or
email administrator can provide you this information), you need to do the following after you have filled
in the Getting Started Settings:

1 Open the Settings dialog by selecting Settings... from the Special menu.

2 Click the Sending Mail category on the left. The Sending Mail Settings are displayed.

3 In the Domain to add to unqualified names field, enter the email address name, if any. (Thus, if you
enter myfirm.com in this field and your address a message to bill.jones, Eudora will expand the address
as bill.jones@myfirm.com before sending or queuing the message.)

4 In the SMTP Server field, enter the name of your outgoing (SMTP) server, as recorded earlier in this guide
and click OK to save your changes. 

Sample Sending Mail Settings
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You can manually check for mail or set up Eudora to automatically check for mail.

Checking Mail Manually

To check for mail manually, do the following:

1 From the File menu, select Check Mail.

2 If Eudora asks for your password, type it in the Password dialog and click OK (Server passwords are
usually case-sensitive).

3 If there is no mail for you, a “no mail” appears. Click OK.

4 If you have new mail, Eudora transfers the messages one by one and then displays a “new mail” alert.
Click OK.

5 New messages are delivered to your In mailbox. This mailbox opens automatically and your new
message summaries are added to the end of the mailbox list. Double-click a message summary to
open the message.

Setting Up Automatic Mail Checking

To set up automatic mail checking, do the following:

1 From the Special menu, select the Settings... command. Then, click the Checking Mail category.

2 Click the checkbox for Check for mail every [___] minutes to turn on automatic mail checking. 
In the text box, type the number of minutes between automatic mail checks (15 is the 
recommended interval).

3 To save your changes and close the Settings dialog,  click OK.

Eudora automatically checks for mail at the interval you have requested.

That’s It!

Once you have configured Eudora, you are ready to begin sending and receiving messages!

For a quick introduction to Eudora’s basic functions, refer to the procedures provided in this guide and to
your online help, which you can access from the Eudora Help menu.

To create a new message and send it, do the following:

1 From the Message menu, select New Message.

2 Type an email address (or a nickname you created) in the To: field.

3 Press Tab to move the blinking cursor to the Subject: field.

4 Type the subject of your message (optional).

5 Press Tab and type in the Cc: field email address (optional).

6 Press Tab and type in the Bcc: field email address (optional).

7 Press Tab and type in the body of the message.

8 After completing the message, click Send (or Queue).

Tip. You can type multiple addresses in the To:, Cc:, and Bcc: fields, as long as you separate
them with commas.

Also, you can save a message without sending it by selecting Save from the File menu. Your message is
saved in the Out mailbox. It can be reopened and edited at any time prior to sending it.

1110

C R E A T I N G  A N D  S E N D I N G  A  M E S S A G E

C H E C K I N G  F O R  A N D  R E C E I V I N G  M A I L
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You reply to a message when you want to respond to its sender.

1 Select or open the message you want to reply to.

2 From the Message menu, select Reply to display a new composition window. Eudora completes the
To:, From:, and Subject: fields based on the original message.

3 Remove those parts of the original text that you don’t want to include in your reply and type in your
own text.

4 When you finish your response, click Send (or Queue).

You forward a message when you want someone else to see it.

1 Select or open the message you want to forward.

2 From the Message menu, select Forward to display a new composition window. Eudora completes
the Subject: field based on the original message and transfers the header and body of the original
message to the new message body.

3 Type the addresses of the people you want to forward the message to in the To: field.

4 The existing text may be edited, and more text may be added to the message.

5 After editing the message, click Send (or Queue).

12

Eudora’s Redirect command lets you send a message that you received to someone else, while allowing
the recipient of the redirected message to reply directly to the original sender.

1 Select or open the message you want to redirect.

2 From the Message menu, select Redirect to display a new composition window. Eudora completes
the From: field with the address of the originator, followed in parentheses by the words "by way of"
and your name and/or email address. The Subject: field and message body are also completed based
on the original message.

3 Type the addresses of the people to whom you wish to redirect the message in the To: field.

4 The existing text may be edited, and more text may be added to the message.

5 Once the editing is completed, click Send (or Queue).

Note.  Email courtesy suggests that you not do much editing of the message you’re redirecting. If you
must add comments, put them in [ ]’s with your initials, like this: [Don: Please reply to this right away. SD]

Many operations in Eudora can be affected by holding down one or more “modifier” keys while
performing another action. In addition to the modifiers below, the Shift and Option keys can be used
to change the Eudora menu commands.

Press these Keys Results

Command + . Stop the current action

Command + 0 Out (open the Out mailbox)

Command + 1 In (open the In mailbox)

Option + Command + 6 Find Next Misspelling

R E P L Y I N G  T O  A  M E S S A G E

F O R W A R D I N G  A  M E S S A G E

R E D I R E C T I N G A  M E S S A G E

S H O R T C U T S

QSG mac  6/22/99  3:13 PM  Page 12



M A C I N T O S H  V E R S I O N

15

Shift + Option + Command + 6 Add to Dictionary (add unknown word to spelling dictionary)

Command + - Send Queued Messages

Command + = Enter Selection (into Find window)

Command + \ Send to Back (move current window to the back of all Eudora windows)

Command + ’ Paste As Quotation

Command + , Finish Address Book Entry (finish nickname)

Command + [ Lower priority

Command + ] Raise priority

Command + A Select All

Command + B Make the selected text bold

Command + C Copy

Command + D Delete

Command + E Send Immediately, or Queue For Delivery

Command + F Find... (open the Find window to search for a text string in the 
current message)

Option + Command + F Search (open the Search window to search through mailboxes 
and mail folders)

Command + G Find Again (in the current message)

Command + H Attach Document... (attach a file to a message)

Command + I Make the selected text italic

Command + J Filter Messages (execute manual filters on the selected messages)

14

Command + K Make Address Book Entry... (make nickname)

Command + L Open Address Book

Command + M Check Mail

Command + N New Message (open one)

Command + O Open... (open file)

Command + P Print...

Command + Q Quit Eudora

Command + R Reply

Command + S Save

Command + T Make the selected text plain

Command + U Make the selected text underlined

Command + V Paste

Command + W Close (close the window or message)

Command + X Cut

Command + Y Open Directory Services

Command + Z Undo/Redo

Arrows Move from one message to another in a mailbox (depends on 
your Moving Around Settings).

Return or  Enter Select the outlined button in any dialog, alert, or window, or 
open the selected message(s).
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Spacebar Open a selected message summary (or scroll its preview down
through the message preview panel), or close the current open
message. For long open messages, scroll the message down 
one page.

Esc Stop any operation currently in progress.

Help Turn Balloon Help on or off.

F1 Undo/Redo, or main toolbar function.

F2 Cut, or main toolbar function.

F3 Copy, or main toolbar function.

F4 Paste, or main toolbar function.

Home Scroll the window to the beginning.

End Scroll the window to the end.

Page Up, Page Down Scroll up or down through the window.

Note: Function keys can be linked to main toolbar buttons by turning on the Map function keys 
to buttons option in the Toolbar Settings (Special>Settings...>Toolbar).

© 1999 QUALCOMM Incorporated, San Diego, CA. 92121.  All rights reserved.
PureVoice is a trademark of QUALCOMM Incorporated. QuickTime is a trademark of 
Apple Computer, Inc. QuickTime is a trademark used under license, registered in
the U.S. and other countries. All other trademarks are property of their respective owners.
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